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Start Here
Congratulations if you’ve obtained a Line 6 POD StudioTM or TonePortTM UX2, UX8 or KB37, 
since you are now equipped not only with a high performance USB audio interface and tone machine, 
but also built in power for remote, hands-free control of the Line 6 GearBox software, as well as 3rd 
party MIDI/DAW software! This document will walk you through setting up and using your Line 6 
POD Studio/TonePort* Footswitch, Pedal & controller features for use with GearBox and 3rd party 
software that responds to MIDI control.

To get the most out of your POD Studio or TonePort with GearBox or MIDI/DAW software, it is 
recommended you first read through the very helpful info in these products’ User Manuals. If you 
cannot find these printed manuals, then you can download them free from the Line 6 Support site at 
http://line6.com/support/manuals/. 

*Note that the both Line 6 POD Studio and TonePort branded  UX2, UX8 and KB37 devices include 
these same MIDI control features. The info in this MIDI Setup Guide applies to both POD Studio and 
TonePort models, unless otherwise noted.

Updating & Registering with Line 6 Monkey

OK, so maybe you already read about doing this updating & registration stuff for your POD Studio/
TonePort, but in case you were too excited with your new gear to get to that yet, now is the time to do 
it! It’s a simple process really, just run Line 6 Monkey on your computer with an Internet connection. 
Line 6 Monkey is the intelligent updater software utility that is typically installed with other Line 6 
software titles. If you don’t already have it installed, you can get free from the Line 6 site at www.line6.
com/monkey/.

Once you’ve installed the Line 6 Monkey software, connect your POD Studio/TonePort to your 
computer’s USB port. Be sure to exit the GearBox application as well as any MIDI/DAW applications 
that might be running. With your computer’s Internet connection active, follow these steps to launch 
Line 6 Monkey...

•	 On Mac®, go to Applications > Line 6 > Line 6 Monkey

•	 On Windows®, go to the Start button menu > Programs > Line 6 > Tools > Line 6 Monkey

  

Login Account

You’ll need to Login so that Line 6 Monkey can communicate with the online Line 6 Server to provide 
the specific product updates for your gear. It’s just a few clicks, and it’s free!

•	 If you have a Line 6 account, type in your User Name and Password at the top of the Monkey 
dialog. 

•	 If you have not yet created an account, click the New User button and you’ll be walked right 
through the steps.

http://line6.com/support/manuals/
http://www.line6.com/monkey/
http://www.line6.com/monkey/
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Register Your Line 6 Hardware

Registration of your Line 6 gear may be required for some updates and product authorizations, and 
is also important because it ensures that you’re dialed in for warranty service and makes it possible 
for us to contact you if new software versions or other cool enhancements are offered - cutting edge 
technology and such! 

If you have not already done so, you’ll be prompted to Register your connected Line 6 device. Just click 
that Register button when prompted and fill in the blanks on the web page. This page will list all your 
registered Line 6 gear in one place. 

Grab those Updates

Once Line 6 Monkey launches, it will automatically detect your connected device. Within the Updates 
page in Line 6 Monkey, if you see any items indicated with an exclamation symbol   then you should 
select the item in the list, click on the Update Selection button, and let the little Monkey fellow walk 
you through the installation steps. Items in the Updates screen indicated with a green check , are 
up-to-date and require no attention. You’ll definitely want to grab the latest GearBox software, since 
we’ll be covering how to use POD Studio/TonePort’s controller features with it - and it’s free anyway, 
so help yourself (more about GearBox in the following chapters).  

Note: If you have a POD Studio device, you’ll also see the Line 6 POD Farm 1.x software as an available 
download. You can install and use POD Farm/POD Farm Plug-In as desired (even if you also have 
GearBox/GearBox Plug-In installed). However, POD Farm 1.x does not offer MIDI control via POD 
Studio, TonePort or 3rd party controller devices.

The columns on the right of the Updates list tell you the version numbers for all currently installed 
items and available updates. Click on any item in the Updates list and refer to its description in the 
Help and Info pane below. Also, at the left you’ll see your connected Line 6 device shown, along with 
its unique ESN (Electronic Serial Number), should you ever need to reference this ID number for 
registration or warranty service. 

Running Line 6 Monkey is the easiest way to stay current on the latest Line 6 software and hardware 
updates!
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Connecting Footswitches and Pedals

The UX2, UX8 and KB37 devices include two 1/4-inch Footswitch jacks for connecting optional  
footswitches. You’ll want the non-latching, “momentary” type footswitch for these connections (such 
as those commonly sold as “sustain pedals” for keyboard controllers). You can connect to either or both 
of these jacks to utilize the independent Footswitch 1 and Footswitch 2 controllers.

The UX8 and KB37 devices include one 1/4-inch Expression jack for connecting an expression pedal. 
The Line 6 EX-1 Expression Pedal is designed to work with the POD Studio & TonePort devices for 
just this purpose - It utilizes a 10k Ohm pot and connects to Line 6 devices with a 1/4-inch TS plug. 
See the next section about calibrating an Expression Pedal. The EX-1 can be purchased  directly on 
the Line 6 Online Store, or from most Line 6 dealers. Most other 3rd party “expression pedal” products 
will work as well.

Connect up to two footswitch pedals 
into these Footswitch 1 & 2 jacks

UX2 Footswitch connections

http://line6.com/store/
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Connect up to two footswitch pedals 
into these Footswitch 1 & 2 jacks

Connect an expression pedal to the 
Expression jack

UX8 Footswitch and Expression Pedal connections

Connect an expression pedal 
to the Expression jack

Connect up to two footswitch pedals 
into these Footswitch 1 & 2 jacks

KB37 Footswitch & Expression Pedal connections

KB37 Wheel, Knob & Button Controllers

In addition to the Footswitch and Expression controllers, POD Studio/TonePort KB37 offers a whole 
set of knobs, wheel, switches and even transport buttons that can be used to control GearBox or 
parameters in  your MIDI/DAW software. These controllers all transmit MIDI Control messages 
out the unit’s USB MIDI Out port, allowing remote control of parameters in real-time. These KB37 
controls are named as follows:

4                   5       6       7      8     9     10       11   12   13  14    15         

16        17       18       19       

3

2

1
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1 Octave Up 11 Transport - Rewind

2 Octave Down 12 Transport - Forward

3 Pitch Bend Wheel 13 Transport - Stop

4 Modulation Wheel 14 Transport - Play

5 Sound Select (Previous) 15 Transport - Record

6 Sound Select (Next) 16 Button 1

7 Knob 1 17 Button 2

8 Knob 2 18 Button 3

9 Knob 3 19 Button 4

10 Knob 4

For information on how to map these MIDI Controllers to GearBox and MIDI/DAW software 
parameters, please see “MIDI Control Configuration” on page 2•1. 

KB37 Note Keys & Pitch Wheel

KB37 note keys and pitch wheel automatically transmit MIDI note and pitch controller messages 
to the KB37 USB MIDI Out port (these do not send any data to GearBox). There is typically no 
configuration required for these - once your MIDI/DAW software is configured to receive MIDI from 
the KB37 MIDI Out port, it should automatically receive the note and pitch bend messages, allowing 
you to record into a MIDI track and trigger software instrument plug-ins. The Octave Select switches 
allow you to change the note range up/down that the device’s 37 note keys transmit, as indicated by 
the Octave Select LEDs. 

For some helpful examples on how to configure your MIDI/DAW software for KB37, please see 
“Controllers and 3rd Party Applications” on page 4•1.

With the above steps complete you should now be ready to dive into the following chapters with 
your Line 6 POD Studio or TonePort gear! 
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MIDI Control Configuration
In this chapter we’ll show you how to configure specifically what MIDI Control messages your POD 
Studio/TonePort’s controllers transmit when you access them. This is all accomplished using the Line 
6 MIDI Control Settings dialog, where you can view and edit these settings, as well as create and save 
your own customized preset control mappings to load any time.

Default MIDI Control Settings

UX2, UX8 & KB37 ship with a default set of MIDI Control Messages assigned to their controllers, 
as shown in the handy table below. Your device will send these MIDI commands right “out of the 
box”, without any further configuration needed. Note that by default your Line 6 device sends out 
two different sets of  MIDI Control messages - one set is transmitted directly to the Line 6 GearBox 
application (if launched), and the other transmitted to the POD Studio/TonePort USB MIDI Out 
port. 

There are a number of preset “Control Mappings” available for you to select from within the Line 6 
Audio-MIDI Devices dialog. The GearBox & MIDI Default preset is the one initially loaded for your 
device. This preset consists of the following controller settings:   

GearBox & MIDI Default Preset Assignments

POD Studio/
TonePort Model

Controller Name GearBox Parameter MIDI Control Message

KB37 Modulation wheel (No Assignment) CC 001 Mod Wheel

KB37 Sound Select (Previous) Next Tone Preset Program Change –1

KB37 Sound Select (Next) Previous Tone Preset Program Change +1

KB37 Knob 1 Amp – Drive CC 073 (Attack Time)

KB37 Knob 2 Amp – Bass CC 075 (Decay Time)

KB37 Knob 3 Amp – Middle CC 072 (Release Time)

KB37 Knob 4 Amp – Treble CC 091 (Effects 1 Depth)

KB37 Button 1 Stomp – toggle on/off CC 065 (Portamento)

KB37 Button 2 Mod – toggle on/off CC 127 (Poly On)

KB37 Button 3 Delay – toggle on/off CC 126 (Mono On)

KB37 Button 4 Reverb – toggle on/off CC 123 (All Notes Off)

KB37 Stop Stop MMC Stop

KB37 Play Play MMC Play

KB37 Record Loop MMC Record Punch

KB37 Rewind Rewind MMC Rewind

KB37 Forward Forward MMC Fast Forward

KB37, UX8 Expression Pedal Wah CC 11 (Expression)
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POD Studio/
TonePort Model

Controller Name GearBox Parameter MIDI Control Message

KB37. UX8, 
UX2

Footswitch 1 Stomp – toggle on/off CC 64 (Sustain)

KB37. UX8, 
UX2

Footswitch 2 Tuner MMC Record Punch

Choosing a Controller Mapping Preset

In addition to the default GearBox and MIDI Default preset described above, there are also several 
presets for specific MIDI/DAW software applications as well. You can select one of these presets from 
the Controller Mapping menu within the Line 6 Audio-MIDI Devices dialog:

•	 Windows® - Control Panel > Line 6 Audio-MIDI Devices > MIDI tab

•	 Mac® - System Preferences > Line 6 Audio-MIDI Devices > MIDI tab

Please see the following chapters for more information regarding the 3rd party application presets. To 
see and edit the individual controller settings, you can launch the MIDI Control Settings dialog, as 
explained in the next section.

Customizing Controller Settings

To customize of any of the individual POD Studio/TonePort controller settings, launch the MIDI 
Control Settings dialog from within the Line 6 Audio-MIDI Settings dialog: 
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To follow is an example of the MIDI Control Settings dialog, as displayed with a connected KB37 
device. Note that if you have a UX2 or UX8, you’ll see only the Controllers offered by those devices  
(Footswitch 1 & 2 for UX2 and Footswitch 1 &2 and Expression Pedal for UX8). See the following 
descriptions for details on the fields within the MIDI Control Settings dialog. 

The Switch/Controller column populates with all re-
assignable controllers for your device (KB37 shown here)

Name and save your custom 
mapping as a preset 

Choose which GearBox Control 
function (if any) to assign to the 
respective Controller

Choose the type of Control, which 
CC/Action it will perform, and the 
Switch Mode for each respective 
controller

Click Apply to commit 
the displayed settings to 
your device, then OK to 
exit the dialog

Switch/Controller - Lists the physical wheel, button, knob or pedal controllers available on your POD 
Studio/TonePort device.

GearBox Control - Allows you to select from a menu what action is performed in the GearBox software 
when the Controller is accessed. Note that you can choose “None” to disable any controller.
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To MIDI Out - Allows you to select from a menu the type of MIDI Control message transmitted to the  
device’s USB MIDI Out port to control your MIDI/DAW software from each controller. The options 
are as follows (note that the Mod Wheel, Knobs, and Expression Pedal controllers are limited to MIDI 
CC or MIDI CC 14 bit options only):

•	 None: Sends no MIDI data. Basically, this is to disable the controller. If you don’t plan on 
using some footswitches or pedals within the preset you are creating, it is best to set these to 
None to avoid unexpectedly triggering functions in your targeted software!

•	 Bank Change: A numerical value typically used to switch through Patch or Preset Banks.

•	 Program Change: A numerical value typically used to switch through Presets within a 
selected Bank.

•	 MIDI CC (MIDI Continuous Control): A set of Value and Range numbers commonly 
used by MIDI  software and hardware to provide access to parameters. 

•	 MIDI CC 14 bit (Wheel, Knob & Exp. Pedal controllers only): A higher resolution MIDI 
CC option - it is best to select this option when controlling a parameter in your software 
that requires greater precision so that you can adjust the control more smoothly without 
hearing “zippering” or large jumps in incremental settings. 

•	 MMC (MIDI Machine Control): Specific commands for commonly used for controlling   
transport buttons and mechanical functions (Play, Stop, Record, etc.)

•	 Mackie Control: Specific commands in the “Mackie Universal Controller” format, 
commonly used for transport parameters and mechanical functions (Play, Stop, Record, 
etc.), for MIDI software that supports the popular Mackie Control format. 

MIDI CC/Action - Sets the Value for the MIDI command type in use. The options differ depending 
on the current setting in the “To MIDI Out” field:

•	 For MIDI CC - Choose the CC value from 0 to 127. You may also choose “Custom” to then 
allow the Toggle 1/Up and Toggle 2/Down options to become selectable, so that the each  
successive Toggle action can be defined with its own separate MIDI CC value.

•	 For Program Change - Choose Increment to switch to the next higher program number, or 
decrement to choose the next lower Program number. (Sends a Program Change value of “1” for 
either option).

•	 For MMC - Choose the MMC command type by name (Play, Stop, Play/Stop toggle, Pause, 
Record Punch, Record Punch-Pro Tools, Rew, FF).

•	 For Mackie Control - Choose the command type by name (Play, Stop, Play/Stop toggle, Pause, 
Record Punch, Rew, FF).

Switch Mode - Sets the switch behavior. These options are available for some MIDI CC, MMC and 
Mackie commands. The three types of switch behaviors are as follows - you may need to check your 
MIDI/DAW software’s documentation to see how its parameters are programmed to respond to these 
different MIDI switch commands:

•	 Single - Sends a single MIDI message and value on each press. This option is best when triggering 
a software function the same each time, such as the playback of a sample.

•	 Toggle - Sends two different MIDI CC LSB values (0 and 127 - typically interpreted as “off” 
and “on”), alternating between the two on each successive press of the switch. Some software 
parameters respond to these toggled  MIDI commands to do things such as toggle a parameter 
on and off. 
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•	 Momentary - Sends a single MIDI message and value (127 - typically interpreted as “on”) only  
while switch is held down only, and then sends a single MIDI message and value (0 - typically 
interpreted as “off”) when switch is released. A common use for this type of switch behavior is 
for  a piano/synth Sustain pedal footswitch.  

* Note – The Mackie Control protocol uses MIDI note events to activate specific functions. When using 
the KB37 as a Mackie Control input device, MIDI note messages may trigger Mackie Control-related 
functions within a given host application. In Ableton Live™ for example, D5 (MIDI note 74) toggles 
between the Arrangement and Session views.

Toggle1/Up Toggle2/Dn CC/Val Columns - These columns become selectable when the MIDI 
Command is set to “MIDI CC” and Value is set to “Custom”. MSB + LSB values can be then be 
entered here to specify the Toggle 1/Up and Toggle 2/Down switch behaviors. This allows these two 
different MIDI CC values to be sent, alternating on each successive press of the switch controller.

Dual-Tone GearBox Settings

When using your Line 6 device to control the Line 6 GearBox software... Note that if you have 
selected one of the Dual-Tone settings in the GearBox Source Select menu, then the controllers will 
affect the parameters for Tone 1 only of your GearBox tone preset. The Dual-Tone settings are the ones 
with the “&” in their names. 

Dual-Tone settings are the ones with 
the “&” in their names

For example, if you are currently using Inst & Mic 1 as your Source, then UX2/KB37 will only trigger 
the assigned functions for the Instrument tone, which is the “Tone 1” of this Source.

Controlling GearBox Functions via MIDI SysEx

Worth mention here is the fact that some GearBox functions are actually controlled via MIDI System 
Exclusive messages (or “SysEx” as the hip MIDI folks like to call it). These GearBox functions include 
Monitor and Send levels, Next/Previous Tone, GPO Track levels, etc. These can be controlled 
externally if you have a MIDI device or software utility capable of sending MIDI SysEx. 

For more information about MIDI SysEx and external control of GearBox, please see the MIDI 
Continuous Controller Reference document, downloadable from the POD Studio or TonePort 
Manuals download page.

http://line6.com/support/manuals/
http://line6.com/support/manuals/
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Guitar Port Online Player Transport Control

In addition, the following MIDI events are recognized for the Guitar Port Online (GPO) Player 
transport control within the GearBox software. These 3 byte MIDI short messages (not SysEx) are 
based on the Mackie control specification.

GPO Transport Function MIDI Message
Track Play 90 5E 7F

Track Stop 90 5D 7F

Track FWD Start 90 5C 7F

Track FWD Stop 90 5C 00

Track REW Start 90 5B 7F

Track REW Stop 90 5B 00
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Controlling Ableton Live™ Software
This chapter includes instructions for using your Line 6 UX2/UX8/KB37 with the Ableton Live 
software, including the Ableton Live Lite - Line 6 Edition, which comes included with some Line 6 
devices. The special Line 6 Edition of this software offers some pre-defined MIDI controller functions 
with your Line 6 hardware. We’ve provided examples here as well for customizing your Line 6 POD 
Studio/TonePort controller mappings, using any Live version’s MIDI Map Mode, controlling effects 
Plug-In parameters and more. These functions are also available in other popular DAW applications, 
and often the procedure is similar for configuring the behavior, therefore, the following tips should be 
a useful guide for using your POD Studio or TonePort to control other applications as well! Also see 
the following chapter for more specific instructions on configuring other popular MIDI/DAW software 
for use with your Line 6 device.

If you received the Ableton Live Lite - Line 6 Edition with your Line 6 product, you can upgrade to the 
latest Live Lite - Line 6 Edition version free at http://www.ableton.com/free-line6-upgrade. If you want 
to try the following examples with the latest Ableton Live full version, you can download a free Demo 
version at  http://www.ableton.com/downloads.

Ableton Live MIDI Input Device Configuration

First, we need to configure the Ableton Live software to receive MIDI from your Line 6  device. In 
Ableton Live, as well as in many other DAW applications, there are separate options for choosing 
a MIDI keyboard (such as for playing a software instrument & recording MIDI notes into a MIDI 
track) and for choosing a MIDI Controller or Control Surface device (for remote control of software 
parameters). The following examples will show us configuring KB37, since it can perform both these 
types of MIDI functions, but we’ll note where any settings might differ for UX2 and UX8.

With your UX2/UX8/KB37 device connected to your USB port, launch the Ableton Live software, 
and go to:

•	 Mac® - Ableton Live > Preferences > MIDI/Sync page

•	 Windows® - Options > Preferences > MIDI/Sync page   

Here you will see that Live automatically detects your Line 6 device’s MIDI ports. You might see 
additional devices’ MIDI Ports appear here as well, depending what other MIDI hardware/software you 
have installed on your computer.

Click the Track 
and Remote 
buttons both 
to On for your 
Line 6 device’s 
MIDI Input*

Select your Line 
6 device here so 
that Live will 
receive MIDI 
Control data 
from it

http://www.ableton.com/free-line6-upgrade
http://www.ableton.com/downloads
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*For UX2 & UX8, it is not necessary to turn the Track button On, since this enables MIDI input into  
Lives MIDI tracks, which you typically need only for a MID keyboard controller to allow you to record 
notes. We’re purposely not assigning anything to “output” MIDI back to your Line 6 device’s MIDI 
port, since we’re only concerned with transmitting MIDI data from your device.

Close the Preferences dialog - this completes the MIDI input device configuration steps.

Ableton Live Controller Mapping Preset 

The easiest way to get started using your UX/2UX8/KB37 as a controller device with Ableton Live 
software is to select the Ableton Live preset in the Line 6 Controller Mapping dialog. This preset  
loads the following MIDI controller settings (UX2 will display only Footswitch controllers, and UX8 
only Footswitch and Expression Pedal controllers):

Note that this preset has all the GearBox Control fields set to “None”, which means your device will not 
transmit any commands to the GearBox application. It is possible to do so to control GearBox and Ableton 
Live or another DAW software simultaneously if you like - please see “MIDI Control Configuration” on 
page 2•1 for details.

If you are using the Live Lite - Line 6 Edition version, the following settings of this preset are “pre-
mapped” already for you in the software. (If you are using a full Ableton Live version, we’ll show you 
how to map these controllers yourself in the next sections).

Footswitch Controller Behaviors - With this Ableton Live preset loaded, the Footswitches provide 
the following behaviors for hands-free control:

•	 Footswitch 1: Toggles the Live transport between Play/Stop functions.

•	 Footswitch 2: Toggles the Live transport Punch Record function.
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Transport buttons (KB37) - The transport buttons are all mapped to provide the following behaviors:

PlayMetronome On/Off

Loop On/Off

Stop Global Record

KB37’s transport buttons - Ableton Live Lite Line 6 Edition “pre-mapped” functions

Using Ableton Live’s MIDI Map Mode

All versions of Ableton Live include this “MIDI Map Mode” feature, which makes it simple to map 
any switch, knob, wheel or pedal controller to a specific parameter in the software. Note that many 
other DAW applications also offer a similar functionality (sometimes referred to as “MIDI Learn”) and 
your Line 6 MIDI controllers will work similarly in those applications as well. The first step is always 
to configure your device’s controllers to transmit a MIDI command, such as we already did by simply 
selecting the Ableton Live preset in the previous steps. Live utilizes MIDI CC commands for most of 
its mappings - other DAW software commonly does as well, but might alternatively utilize MMC or 
Mackie commands for some functions (please check your DAW software’s documentation details). 

As an example, we’ll show you how to set up the Start/Stop and Punch In/Out functions for the 
TonePort UX2/UX8/KB37 footswitches manually. In the Line 6 MIDI Control Settings dialog, 
configure the MIDI settings shown below for the Footswitch 1 & 2 controllers. Be sure to click the 
Apply button after making the settings or they will not be established on your device!

In Ableton Live, follow these steps…

In the upper right corner of the main window, 
click on the MIDI button. It should light up 
blue, indicating you have entered “MIDI Map 
Mode”

Then go over to the Transport and click 
once on the Play button
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Press Footswitch 1. The numbers 1/2 
appear inside the Play Button. This is 
telling you that the button is “mapped” 
to respond to MIDI Channel 1, MIDI 
CC 2

Click on the Stop button then press 
Footswitch 1 again. Since we configured 
the Footswitch to toggle between 
transmitting CC 2 & CC 3, this button 
now receives the CC 3 value

Now click on the Record button, then 
press Footswitch 2.  This now maps 
MIDI CC 6 to toggle Record on/off

Click on the MIDI button when done, to exit 
MIDI Map Mode

You’re done! Give the footswitches a try and you should see Live’s transport trigger accordingly. Using 
the same procedure, you can now map any of  your POD Studio/TonePort controllers to other Ableton 
Live functions.  Read on for more examples.

Mapping the Expression Pedal Controller

Next, we’ll map the Expression Pedal controller to one of Live’s software parameters so that we can 
control it hands-free! The Expression Pedal transmits a stream of MIDI CC values, so you can map to 
any available Live parameter that has a range, such as an effect knob or slider. We’ll first map the pedal 
to Live’s Chorus effect - Dry/Wet parameter. This will allow us to change the Dry/Wet mix of Live’s 
Chorus effect in real-time. Note that this also makes it possible to “write” parameter automation in 
real-time using the Expression Pedal - more on that later...

•	 Connect an Expression Pedal into the Expression jack on your UX2/UX8/KB37, and launch the 
Line 6 MIDI Control Settings and configure the Expression Pedal controller to send a MIDI CC  
- we’ll use CC 5. Your settings should look like this (and remember to click the Apply button 
when done):

•	 In Ableton Live, first record or load an audio file in an audio track so that you have something 
to play and hear your effect in action. 

•	 Load the Chorus as an insert effect on this audio track - You can do this by selecting 
Effects>Chorus>Chorus in the Live Devices panel and then drag this Chorus effect on top of 
your audio track to insert it. 
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Drag the Chorus effect to your 
Audio track to insert it.

•	 You’ll then see the Chorus effect module appear in Live’s lower effects panel. Now place Live 
into MIDI Map Mode (see the instructions in the previous section). Once in Map Mode, you 
will see the Chorus effect’s “map-able” parameters highlighted. 

•	 We’re going to map to the Chorus Dry/Wet knob. Just click on the knob and Live will then wait 
to receive a MIDI Control command. Move your Pedal until you see the text at the bottom of 
Live’s screen indicate that the Dry/Wet parameter was successfully mapped:

Click on the Dry/Wet knob.

The text at the bottom field of Live indicates it 
is waiting for you to press a Controller on your 
MIDI device to map it.

The newly mapped MIDI Channel 1/CC 5 is 
now displayed.

The text shows mapping details.

•	 Since we configured the Pedal controller to send MIDI CC 5, you should see that Live’s Chorus 
Mix knob is mapped to Channel 1, CC 5.
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Exit Live’s MIDI Map Mode and give it a try - You should see the Chorus Dry/Wet knob respond to 
your Expression Pedal’s movement! You can repeat the above steps and map the pedal to any other 
Live effects’ knobs or even the Live Mixer faders & knobs. Or, if you have a KB37, you can map KB37’s 
knob or Mod Wheel controllers following the above steps as well.

Mapping to an AU/VST Effect Parameter

As with most other DAW software, with Ableton Live you are not just limited to mapping your 
controllers to Live’s parameters. Once a 3rd party AU or VST Plug-In is loaded in the software, it 
is also possible to map to the Plug-In’s parameters. In this example we’ll show  you how to map the 
Expression Pedal controller to the Line 6 POD Farm Plug-In’s Wah Position parameter. This allows 
you work the pedal and control the POD Farm Wah effect in real-time! These steps would be similar 
for the Line 6 POD GearBox Plug-In, or most any 3rd party AU or VST Plug-In effect you might have 
available.

•	 In the Line 6 MIDI Control Settings dialog, configure your Expression Pedal controller to send a 
MIDI CC  - we’ll again use CC 5. Your settings should look like this (and remember to click the 
Apply button when done):

•	 In Ableton Live, record or load an audio file in an audio track. A recorded clean rhythm guitar 
would work nicely here. We’re working in Live’s “Arrangement View” here.

•	 In Live’s Plug-In Devices Browser panel, select your Plug-In and drag it on top of your audio 
track.

•	  You’ll see the effect module load into Live’s lower panel. If you click on the little arrow at the 
top of this effect module, you’ll see it expands to expose a Configure option. This allows you to 
add parameters from the Plug-In’s edit window so that it is accessible within the effect module 
display. 
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Click the Configure button to add a 
POD Farm Plug-In parameter to this 
module

Click the arrow here to expand the 
effect module...

Now, in the POD Farm Plug-In window, 
click directly on the Wah edit panel’s 
Position knob to select this parameter.

Once you’ve selected the Plug-In parameter, you’ll 
see a slider appear in the Line effects module for that 
parameter.

•	 Now just follow the same steps as in the previous examples to enter Live’s MIDI Map Mode, click 
on the parameter in the effect module, and then move your Expression Pedal to map it. For our 
example, we now have successfully mapped Channel 1, MIDI CC 5 from our Pedal to the Wah 
Position parameter. Exit MIDI Map Mode.  

Go ahead and hit Play in Live and work your Expression Pedal and you’ll hear the mapped effect 
parameter do its thing. You might also see the control for the selected parameter within the effect’s 
own window move in response as well. In our case, the POD Farm Plug-In Wah Position knob moves 
in response. But wait - it gets better! Read on for more fun with mapped parameters!
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Control Automation Recording with your Expression Pedal

Once you have a parameter mapped to your Expression Pedal (or KB37 knob or Mod Wheel controller), 
in many cases the DAW software will also allow you to “record” your controller’s moves in real-time 
as an automation envelope on your track. The perfect example for this is for us to use the POD Farm 
Plug-In Wah mapping we just created in Ableton Live, and record our Expression Pedal moves to add 
some snarky wah action on our guitar track. Other DAW applications differ in the exact way they 
offer track and effects automation, so be sure to check your DAW software’s documentation. But this 
example should give you the basic idea. With the Expression Pedal controller successfully mapped to 
the POD Farm Plug-In Wah (or the Plug-In parameter of your choice) try the following steps...

•	 In Live’s Arrangement View, you’ll want to make sure your audio track is not armed for recording 
(since we only want to record automation on this track, not audio). You should also see the POD 
Farm Wah-Position parameter shown here on the track. Note that right now when you move 
your Expression Pedal, an existing, flat envelope line across the track moves up and down in 
response. 

Once we mapped the POD Farm Wah-Position parameter in the previous steps, our Live audio 
track shows this parameter in its automation selector, and shows an (unedited) envelope across 
the track. If you move your pedal, you’ll see this envelope line respond.

Keep this track Record Arm button “off” for these steps.

•	 Rewind to the start of the track, click Live’s main Transport Record and then Play button. Once 
Live starts rolling, just start working the Expression Pedal as desired to add the Wah effect to 
your track. You’ll see envelope “edit points” added, recording your pedal moves as you go.

•	 Stop Live and then play the track back and you’ll hear that your Wah pedal “performance” was 
captured in real-time. Not happy with that take? Just undo, or zoom in and use your mouse to 
manually adjust the edit points to fine-tune the wah performance. 

KB37 Keyboard Functions

With the previous Ableton Live Preferences settings complete, you should immediately be able to 
utilize KB37 as a music keyboard to record MIDI notes into Live’s MIDI tracks, and to trigger Live’s 
software instruments. All you should need to do is to configure Live’s MIDI track input settings to 
receive MIDI input from your KB37:
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•	 In the Live MIDI Track I/O settings header, set the Input to receive from either Channel 1 or All 
Channels, since KB37 is always transmitting on MIDI Channel 1. Then click the Record Arm 
button to arm the track. You should then see the MIDI input meters on the track respond when 
you hit note keys on your KB37. 

Set the Channel input and arm the 
MIDI track.

You’ll see the MIDI meters flash 
when you hit a note key.

•	 Hit the Live Record + Play transport buttons and start recording your MIDI keyboard performance

Please refer to Ableton Live’s tutorials for details on inserting a software instrument and other MIDI 
track functions.

Now that you have the basics, you should be able to map your UX2/UX8/KB37 controllers to a 
plethora of different MIDI & DAW software mix functions, transport buttons, effect parameters, Plug-
In parameters, and even use your controllers for writing automation. Please see the following chapter 
for MIDI Control setup of your Line 6 device with other popular DAW applications.
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MIDI Control with 3rd Party Applications

In this chapter, we’ll cover how to setup several popular DAW applications to utilize your POD Studio/
TonePort UX2/UX8/KB37 as a MIDI controller device, as well as a few handy tips for some of these 
applications. If you have not already done so, please read through “Controlling Ableton Live Software” 
on page 3•1 since it includes MIDI control aspects that are common to many DAW applications. Check 
your MIDI/DAW software’s user manual for more information regarding its specific MIDI Control 
capabilities as well.

Propellerhead Reason™

The Line 6 Audio-MIDI Devices dialog includes a Controller Mapping preset that configures POD 
Studio/TonePort KB37 for use with Reason. Due to Reason’s dynamic MIDI environment, the KB37 
works with Reason’s Remote™ interface via a Remote codec for KB37, which is installed with GearBox 
3.x.

IMPORTANT: Reason version 3.04 (or later) is required for the Remote codec, so be sure to install the 
latest available Reason update (see http://www.propellerheads.se). Reason must also be installed before 
installing GearBox in order for the Remote KB37 codec to appear.  Running the GearBox installer again 
after installing Reason (or after running a Reason update installation) can fix this problem.

 

What is the Reason Remote™ Codec?

The Remote codec performs the task of mapping KB37 MIDI controller messages to Reason-specific 
functions. For example, the codec automatically maps the KB37’s transport buttons to Reason’s 
transport functions. 

But there are hundreds of knobs and buttons in Reason, and fewer controllers on the KB37. To manage 
all those Reason parameters, the Remote codec maps the knobs and buttons to various Reason device 
parameters (by “Reason devices” here, we’re referring to Reason’s software instruments), relative to 
the currently selected track. Therefore, a default map for the KB37’s buttons and knobs exists for each 
Reason device. 

To use the KB37 with Reason’s Remote codec:

•	 In the Line 6 Audio-MIDI Devices dialog, select the “Reason 3” preset and click OK:

http://www.propellerheads.se
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•	 In Reason, open the “Control Surfaces and Keyboards” page in Reason’s Preferences dialog, click 
‘Add’, then select “Line 6” from the Manufacturer list:

Voila! You should see the KB37 
picture appear in the Model box.

Select KB37 for the In Port.

•	 Select your KB37 device for the In Port, click OK to exit the Control Surface dialog, then exit 
the Preferences.

These Preferences settings configure KB37 to be the “Master Keyboard” controller device for Reason, 
also allowing you to record MIDI into Reason’s sequencer and trigger the many software instrument 
“devices” in Reason. Please refer to your Reason documentation for accessing these MIDI functions 
with your assigned Master Keyboard.

KB37 Mapping Variations 

Because most Reason devices have more parameters than the KB37 has physical controls, we have 
provided mapping variations to allow you to switch the function of your KB37 controllers between 
Reason’s many options. 

When selecting a mapping variation, a new set of parameters will be configured for KB37 with a selected 
Reason device. For example, the KB37’s “Sound Select” buttons are mapped to move up and down 
across tracks. Variation 2 maps the buttons to the target device’s “patch up/patch down” parameters. 
To switch between mapping variations in Reason, you need to use the following keystrokes: 

Mac

[Command] + [Option] + numerical keys [1] to [10].
[1] selects the default standard mapping 

Windows

[Ctrl] + [Alt] + numerical keys [1] to [10]

[1] selects the default standard mapping 
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Tip - You can get an overview of which Reason parameters are assigned to a given mapping variation by 
selecting “Remote Override Edit Mode” from Reason’s Options menu. Also see the Remote Override 
section page 4•4 for information on how to customize your KB37 controller mappings.

Configuring UX2/UX8 as a Generic MIDI Control Surface

The Line 6 UX2 or UX8 devices of course do not include the note keys and knobs & switches like a 
KB37 to allow you to play Reason’s instrument devices, record MIDI performances, etc. However, UX2 
& UX8 both do offer the Footswitch controllers, and UX8 the Expression Pedal controller, which can 
be used to trigger and control parameters in Reason! To configure UX2 or UX8 for this functionality, 
you’ll need to set them up in Reason as a “generic” MIDI Control Surface. Just follow these steps (these 
steps are the same in Windows or Mac OS X)...

•	 In Reason’s Preferences dialog, select Keyboards and Control Surfaces and click the Add button, 
then select None in the list of devices.

•	 Make the following settings in the Control Surface dialog:

Select MIDI Control Surface as the Model.

Type in a name for your device (this is how it will 
appear in Reason’s MIDI Controller menus). 

Choose your UX8/UX2 here to allow Reason to 
receive MIDI from its USB MIDI port.

Click OK when done.
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•	 You should now see your UX8/UX2 device configured accordingly. Exit the Preferences if all 
settings appear as shown here:

Please see the next section for how to map your UX8/UX2 controllers to Reason parameters.

Configuring Line 6 MIDI Controllers with Remote Override

Reason also offers its “Remote Override” feature, which is an easy way to allow Reason to “learn” the 
MIDI message coming from your MIDI control device and instantly map it to a Reason parameter. You 
can use the Remote Override options whether you have the KB37 Reason Remote configuration, or for 
your UX2/UX8 when configured as a generic MIDI Control device. If you are using a KB37, you can 
keep it configured with the steps outlined in the first sections of this chapter.

If you are using a Line 6 UX2 or UX8 device, follow the steps in the previous section to configure 
your device as a MIDI Control Surface. Then launch the Line 6 Audio-MIDI Devices dialog and go 
to MIDI tab. 

Here you can select the Reason 
3 preset, then click the Settings 
button to launch the MIDI 
Control Settings dialog.
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•	 Here you can see the UX8’s Expression Pedal is already set to transmit MIDI CC 11. We’ll next 
show how to map the Expression Pedal to a Reason parameter.

•	 In Reason, right-click (Windows) or Ctrl-click (Mac) on any knob or slider that you want to 
control with your Expression Pedal. We’ll choose the FREQ knob of one of Reason’s synth 
devices...

Right-click/Ctrl-click directly on the knob 
you want to control...

Then choose Edit Remote Override 
Mapping...

•	 In the dialog, just check the box for “Learn From Control Service” and Reason will wait to 
receive a MIDI CC message from your assigned MIDI Control Surface.

Move your Expression Pedal and you 
should see the Control Surface Active 
indicator receive a MIDI signal. Once it 
does, the Control Surface and Control fields 
above will fill in automatically with the 
“learned” MIDI device name and CC value.

Click OK once the step is complete.

•	 And that does it! Now if you move your Expression Pedal, you should see the selected knob move 
in response. You can follow these same steps to map any UX8/UX2/KB37 controller directly to 
any assignable Reason knob, slider, switch, etc. 

The Reason Remote Override feature offers several other features - it is recommended you check 
Reason’s Help documentation covering all that this powerful feature offers for your Line 6 MIDI 
Controllers!
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Apple GarageBand™

POD Studio/TonePort KB37 works automatically with GarageBand to record MIDI notes and trigger 
the Software Instruments within a GarageBand Instrument track - all that is needed for this is to 
connect the KB37 to your Mac’s USB port and then launch GarageBand. When a Software Instrument 
track is selected, playing on the KB37 keyboard will trigger its assigned instrument, and the Pitch 
and Mod wheel will often each control a performance parameter, depending on how the Software 
Instrument is written to utilize them. 

Additionally, the Line 6 Audio-MIDI driver includes a MIDI Mapping preset that configures KB37’s 
Knob 1 and Knob 2 to control the current GarageBand track’s Volume and Pan, respectively. To load 
the GarageBand preset, launch GearBox and open the Preferences dialog from the GearBox menu, 
then select the MIDI/Control tab.  In the MIDI Mapping menu, select the GarageBand preset:

Unfortunately, GarageBand uses its own proprietary protocol for controlling most of its other parameters, 
therefore, the UX2/UX8/KB37’s MIDI controllers cannot access other GarageBand functions directly. 
However, there are 3rd party software utilities you can install on your Mac® that will allow you to use 
the KB37 Transport buttons to control GarageBand’s transport functions. 

In order to control the Transport functions in GarageBand with the KB37 you will need to have 
version 2.0.1 of Garageband or later. The Garageband software cannot do this natively and so you will 
need to download add-on software that permits MIDI messages to control the play and stop buttons 
in Garageband.

GarageRemote is one such 3rd party software and is available here: http://www.muratnkonar.com/
otherstuff/garageremote/

Once GarageRemote is installed and set up, start GarageRemote’s ‘Listener’ (it is off by default) so that 
it can relay MIDI notifications to GarageBand. GarageBand responds to MIDI CC’s 007 and 010 for 
current track volume and pan, and these parameters can be assigned to the existing GarageBand MIDI 
preset of the Line 6 Audio-MIDI Devices settings.

http://www.muratnkonar.com/otherstuff/garageremote/
http://www.muratnkonar.com/otherstuff/garageremote/
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Apple Logic™ 

POD Studio/TonePort KB37 can be used as a keyboard controller with Apple Logic™ Pro or Express 
to record notes and play software instruments in Logic’s Instrument tracks. Additionally, the MIDI 
controllers (buttons, knobs, wheels, footswitches, expression pedal) on KB37, as well as UX2 & UX8, 
can be configured to trigger Logic’s Transport functions, mixer faders, software instrument & plug-in 
parameters and more! To follow are the instructions for configuring KB37/UX2/UX8 to function with 
Logic Pro 8 (the steps should be similar for other versions of Logic as well).

Note that Line 6 POD Studio & TonePort KB37, UX2 & UX8 are also capable of acting as your Core 
Audio device for Logic as well - you can choose within Logic’s Preferences > Audio settings if you want to 
use set it to utilize your connected Line 6 device, or a different audio interface, as your Core Audio device. 
Either way, your connected KB37/UX2/UX8 will perform the MIDI functions described in this chapter.

Simply connecting your KB37/UX2/UX8 to your Mac’s USB port and then launching the Logic 
software should allow it to be detected by Logic, and allow Logic to receive MIDI from your device. 

MIDI Controller Settings Dialog

First, with your Line 6 device connected to your USB port, go to Mac System Preferences > Line 6 
Audio-MIDI Settings dialog...

•	 Select the MIDI Default preset, then click on the Settings button to launch the MIDI Controller 
Settings dialog so that we can view the settings.
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•	 Above shows the MIDI Default preset settings for a KB37. For UX2 you’ll see only the Footswitch 
1 &2 rows, and for UX8 the Footswitch 1 & 2 and Expression Pedal rows. We don’t need to 
make any changes, but should you want to change any MIDI commands sent by your device’s 
controllers, this is where to do it.  Remember to always click Apply after making changes to 
commit them to your device. Click OK to exit the dialog.

The above steps assigns MIDI commands to all the device’s MIDI Controllers for us so that we can 
then map them in Logic. The steps also configure all KB37’s transport button controllers to transmit 
the necessary MMC (MIDI Machine Control) commands to control Logic’s transport. Note that if you 
have a UX2 or UX8, you can alternatively set your Footswitch controllers to send MMC messages to 
have them each control a Logic Transport function. If you choose to do this, see the additional settings 
needed in the following KB37 Transport Buttons section.

KB37 as a Logic Keyboard Controller

All you should need to do is connect KB37 to your USB port before launching Logic, and then activate 
the Record Arm button on a Software Instrument track in Logic. You should then see the Software 
Instrument track’s meters detect the MIDI note input when you hit your KB37 note keys. Press record 
and your performance should record in the track. 

You can of course insert any Logic or 3rd party Software Instruments on this track and your KB37 
will trigger them, allowing you to take full advantage of all the sounds they provide. Your KB37 Pitch 
Bend and Mod Wheel controllers may control different parameters, depending on how the particular 
Software Instrument is designed to utilize them. Likewise, if you connect a momentary switch pedal 
to your KB37 Footswitch 1 jack, it should behave as a sustain pedal with some Software Instruments, 
if they are designed to utilize this (note that the MIDI Default preset we selected in the previous step 
assigned MIDI CC 064 to your Footswitch 1 pedal, which many software piano & synth instruments 
utilize by default for a sustain pedal). 

Check out Logic’s Help documentation for more on how to configure your Software Instrument tracks  
and utilize Software Instruments and Plug-ins with your keyboard controller.
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KB37 Transport Buttons

To set your KB37’s onboard transport buttons to control Logic’s transport controls, you need to set 
Logic to “listen” for the MMC commands that these KB37 buttons are now configured to transmit...

•	 With KB37 connected to your computer’s USB port, launch Logic and go to Preferences > 
MIDI.

•	 Select the Sync tab.

•	 Click the MIDI Sync Project Settings… button at the bottom right of the Sync tab - this 
launches the Song Settings dialog.

•	 In the section labeled MIDI Machine Control (MMC), check the Listen to MMC Input option.

Note that this is a per-Song option in Logic. To make this option “global”, you must modify your Logic 
template file with this MMC setting. 

Mapping Controllers with Logic’s MIDI Learn Function

Logic Pro includes support for several MIDI “Control Surface” devices, which are typically large 
hardware units including faders, knobs, and other controls to emulate a large analog mixing console. 
The Line 6 KB37/UX2/UX8 are not included as Logic supported Control Surface devices, however, 
you can still easily map any of your Line 6 MIDI controllers to Logic or Plug-In parameters by using 
Logic’s MIDI Learn feature! To follow we’ll show you how to map your Expression Pedal to control 
the Wah Position parameter of an inserted GearBox Plug-In. These same steps can be followed to 
map any other button, knob or footswitch on your Line 6 device, to any Logic parameter as well. It is 
recommended that you read through Logic’s Control Surface Support documentation as well to learn 
more about Logic’s MIDI Learn and controller capabilities.

First, here’s a handy tip in Logic... The Logic Pro transport always shows you when MIDI data is 
being received, and specifically the MIDI Channel, command type and value. For example, watch the 
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transport indicator and move a knob, pedal or footswitch on your KB37/UX2/UX8, and you’ll see this 
MIDI In information displayed. In this screenshot, we just moved our Expression Pedal all the way 
forward, so we see the MIDI In show us that Logic last received on MIDI Channel 1, CC 11 with a 
Value of 127:

This indicator can be very helpful to confirm Logic is receiving MIDI from your device, and specifically 
it’s MIDI command & values without always having to go back to the Line 6 MIDI Controller Settings 
dialog!

For this example, we’ll map the Expression Pedal of our KB37 to the GearBox Wah Position parameter. 
If you do not happen to have the GearBox Plug-In, you can insert any Logic or Audio Units  effects 
Plug-In and perform the same steps...

•	 Create an Audio track in your Logic session, and record or insert an audio file so you’ll have 
something to hear your Plug-In effect applied to. A nice clean guitar recording wold work nicely 
here.

•	 Click on an Effects Insert slot for this Logic Audio track and insert the GearBox Plug-In.

•	 In the GearBox Plug-In window, load a Tone preset, and click on the Wah pedal effect to make 
sure it is “on” and to show the Wah effect’s edit settings in the edit panel.

The GearBox Plug-In Edit Panel, Wah effect 

•	 Now click directly on the GearBox Wah Position knob in the edit panel with your mouse and 
move it  a bit - this allows the Wah Position parameter to be “selected”.

•	 Next, (before you click on anything else) go to the Logic > Preferences > Control Surfaces 
menu, and you want to select Learn Assignment for “Wah - Position”.
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•	 As you can see by the name of the “Learn Assignment...” menu command, Logic automatically 
detected the GearBox Plug-In “Wah - Position” parameter since it was the last item you selected 
with your mouse in the previous step.

TIP: Alternatively, you can use the Command+L key shortcut instead of going to the Logic Preferences 
menu.

•	 When you now select this “Learn Assignment...” menu command, it launches the Logic 
Controller Assignments dialog, and a message informs you that it is waiting for you to access 
your MIDI Controller so that it can “Learn” the MIDI command from it.

Note that the Controller Assignment dialog also offers an “Expert View” - this offers many more options 
and allows you to further manually map MIDI controllers. Please see the Logic documentation for this 
dialog if you want to explore this further! The Easy View works great for instantly mapping a controller.

•	 Now move your Expression Pedal, and you should see the Controller Assignment dialog receive 
and “Learn” the MIDI Control message (which is configured to transmit MIDI CC 11, with a 
Value range of 0 - 127, as part of the MIDI Default preset we previously selected in the Line 6 
Audio-MIDI Settings).

You’ll see the “Learned” MIDI 
Control command listed here. 

•	 Exit the Controller Assignments dialog and give the Expression Pedal a try. You should see the 
Position knob within the GearBox Plug-In window move in response. Press Play in Logic to hear 
your audio track play, and when you move the pedal, you should hear the GearBox Wah effect 
do its thing on your track!

•	 Note that you can also set your Logic Audio track to record automation for this GearBox Plug-
In, Wah Position parameter, and you can use the pedal to record a Wah “performance” too.

You should be able to repeat the above steps to access any mappable parameter in Logic with any of 
your KB37/UX2/UX8 MIDI Controllers - Mixer faders, Pan knobs, solo switch, Software Instrument 
knobs, other Plug-In parameters, etc.  So free up your hands and start playing!
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Cakewalk SONAR™

POD Studio/TonePort KB37 can be used as a keyboard controller in Cakewalk SONAR™ to record 
notes and play software instruments in MIDI & Instrument tracks. Additionally, the MIDI controllers 
(buttons, knobs, wheels, footswitches, expression pedal) on KB37, as well as UX2 & UX8, can be 
configured to trigger SONAR’s transport functions, mixer faders, software instrument & plug-in 
parameters and more! To follow are the instructions for configuring KB37/UX2/UX8 to function with 
Cakewalk SONAR Producer 8 (the steps should be similar for other versions of Cakewalk’s SONAR 
and Home Studio versions as well).

Note that Line 6 POD Studio & TonePort KB37, UX2 & UX8 are also capable of acting as your ASIO 
audio device for SONAR as well - you can choose within SONAR’s Options > Audio settings if you want 
to set it to utilize your connected Line 6 device, or a different audio interface, as your ASIO device. Either 
way, your connected KB37/UX2/UX8 will perform the MIDI functions described in this chapter.

 MIDI Controller Settings Dialog

First, before launching SONAR, connect your Line 6 device to your USB port and go to the Windows 
Control Panel > Line 6 Audio-MIDI Settings dialog > MIDI tab...

•	 Select the MIDI Default preset, then click on the Settings button to launch the MIDI Controller 
Settings dialog so that we can edit a few settings.

•	 Make the following changes in the MIDI Controller Settings dialog:

•	 Change the “Sound Select Prev” and “Sound Select Next” controllers each to “MIDI CC” 
for the To MIDI Out fields, and then to” CC 014” and “CC 015”, respectively, for the 
MIDI CC/Action fields. Set the Switch Mode settings for each to “Momentary”.

•	 In the Preset field, at the top right of the dialog, type in “SONAR” and then click the 
Save button so that you have a SONAR controller preset stored on your PC for your Line 
6 device. 
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•	 Your SONAR preset settings should now look like the above for KB37. If you are using UX2 
you’ll see only the Footswitch 1 &2 rows, and for UX8 the Footswitch 1 & 2 and Expression 
Pedal rows.

•	 Click Apply after making changes to commit them to your device. Click OK to exit the 
dialog.

The above steps assign MIDI commands to all the device’s MIDI Controllers for us so that we can then 
map them in SONAR. The steps also configure all KB37’s transport button controllers to transmit the 
necessary MMC (MIDI Machine Control) commands to control SONAR’s transport, and MIDI CCs 
and Program Change messages to trigger other SONAR functions. Note that if you have a UX2 or 
UX8, you can alternatively set your Footswitch controllers to send MMC messages to have them each 
control a SONAR Transport function. 

Configure SONAR’s MIDI Device Settings

To set SONAR so that it can receive keyboard and surface controller MIDI data from your KB37/UX2/
UX8, you’ll need to select your device in SONAR’s MIDI Device Settings dialog. Be sure to always 
have your Line 6 device connected to your USB port before launching SONAR. Launch SONAR and 
go to SONAR’s Options/MIDI Devices and check the KB37 as the MIDI Input device and choose OK.
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KB37 as a Keyboard Controller

Once you’ve selected KB37 as a MIDI Input device in the previous step, all you need to do to utilize 
KB37 as a MIDI keyboard is to  activate the Record Arm button on a SONAR MIDI track and 
set the track’s Input option KB37 (from MIDI Channel 1 or Omni). You should then see the MIDI 
track’s meters detect the MIDI note input when you hit your KB37 note keys. Press record and your 
performance should record in the track. 

You can of course insert any Cakewalk or 3rd party Software Instruments and your KB37 will trigger 
them from your MIDI track, allowing you to take full advantage of all the sounds they provide. Your 
KB37 Pitch Bend and Mod Wheel controllers may control different parameters, depending on how 
the particular Software Instrument is designed to utilize them. Likewise, if you connect a momentary 
switch pedal to your KB37 Footswitch 1 jack, it should behave as a sustain pedal with some Software 
Instruments, if they are designed to utilize this (note that the MIDI Default preset we selected in the 
previous step assigned MIDI CC 064 to your Footswitch 1 pedal, which many software piano & synth 
instruments utilize by default for a sustain pedal). 

Check out SONAR’s Help documentation for more on how to configure your MIDI tracks and utilize 
Software Instruments and Plug-ins with your keyboard controller.

Use KB37/UX2/UX8 as a Surface Controller

SONAR includes its own ACT MIDI Controller Plug-In feature, which allows you to easily create, 
customize and save mappings  for any MIDI surface controller. SONAR’s ACT feature is very powerful 
and it is recommended that you read SONAR’s documentation. For the latest versions of SONAR, 
Cakewalk has included a handy Line 6 KB37 ACT preset, which offers pre-mapped functions for 
KB37’s  knobs and other controllers - for UX2 & UX8 we’ll show you how to create your own mappings 
for the Footswitch or Pedal controllers. Open or create a new project in SONAR, and then follow 
these steps...

•	 Go to SONAR’s Options > Controllers/Surfaces.

•	 In the Controllers/Surfaces dialog, click the “Add new Controller/Surface” button. For 
Controllers/Surfaces, choose “ACT MIDI Controller”, and for Input Port choose your Line 6 
KB37 (or UX2 or UX8 if that is what you are using). You can set Output Port to “None”, then 
click “OK”. Your settings should now look like this:

•	 Close the Controllers/Surfaces dialog when done.

•	 Next, go to Views > Toolbars and ensure the Controllers/Surfaces box is selected, then close the 
window. You’ll see this adds some handy ACT options to your SONAR Toolbar.
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•	 In the ACT Controllers toolbar options, click the Controllers/Surfaces Properties button that 
is at the right end of the Control Surfaces toolbar.

For UX2 and UX8, you can skip ahead to the following “SONAR ACT and MIDI Learn” on page 4•16 
section since you’ll need to use the MIDI Learn function to map your Footswitch/Pedal controllers, but 
reading the rest of the points in this section is likely helpful to see a bit about how ACT works!

•	 In the Properties dialog, select the Line 6 KB37 preset from the menu. You’ll see that this loads 
a number of “pre-mapped” settings for your device. Note that these mappings are designed to 
work with the MIDI commands that we configured in the earlier step when we created the Line 
6 MIDI Controller Settings - SONAR preset for your device. 

•	 Click on the Rotaries Mode - Multi Channel and Control Group - Track options to select them, 
then click your mouse within Sonar’s main track area so that your “focus” is placed on this main 
area of SONAR* - your ACT MIDI Controller dialog appears like the following screenshot.

*Note that the preset’s Controller assignments within the ACT MIDI Controller dialog will change if you 
click and place focus on different SONAR windows, such as if you click in the properties window of a 
loaded Plug-In. More on this later!
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If you are using KB37, you can go ahead and try the knobs, sound select button & transport button 
controllers on your KB37 device and they should control the following SONAR functions:

•	 Knobs - These knobs map to different SONAR functions, depending on what “Bank” you have 
selected in the Act MIDI Controller dialog. To change the knob functions between the following 
four modes, choose Bank 1 - 4 for the top row Bank selector in the dialog’s Controllers tab:

•	 Bank 1 = Volume, tracks 1 - n

•	 Bank 2 = Pan, tracks 1 - n

•	 Bank 3 = Send 1 Level, tracks 1 - n

•	 Bank 3 = Send 1 Level, tracks 1 - n

•	 Note that you can also change the Rotaries Mode and Control Group options at the 
bottom of the ACT MIDI Controller dialog to have the knobs control different pre-mapped 
functions.

•	 Sound Select buttons - You can use these buttons to toggle through SONAR’s next or previous 
set of 8 tracks, so that your KB37 knobs access this “bank” of tracks.

•	 Up arrow button = Next Track Bank

•	 Down arrow button = Previous Track Bank

•	 Transport buttons

•	 Rewind = Go to beginning

•	 FF = Go to end

•	 Stop = Stop

•	 Play = Play

•	 Record = Record

As mentioned in the note above, if you keep the ACT window open but then click on a software 
instrument or effect plug-in window, you’ll see the control assignments in the ACT window change 
to show you that the KB37 knobs now offer control over many of the plug-in’s parameters. If you click 
on the Bank menus at the left of the ACT window’s Controllers tab to select the Banks 1 - 4, you may 
see  additional plug-in parameters as well (depending on the number of parameters the plug-in offers). 
These parameters should all be mapped automatically to KB37’s knobs, transport and sound select 
buttons for you. To customize your mappings, you can use ACT’s MIDI Learn capability - read on.  

SONAR ACT and MIDI Learn

It is also possible to individually map any of your KB37/UX2/UX8 MIDI controllers to SONAR 
functions within the ACT MIDI Controller dialog. The easiest way to try this is to follow the previous 
steps up until the step to choose the Line 6 KB37 preset within the ACT MIDI Controller window. 
Instead, chose the Default preset from the SONAR ACT MIDI Controller’s Presets menu.  When this 
preset is loaded, you’ll see that the “cells” in the dialog allow access to numerous SONAR parameters. 
Also, when you click on a Plug-In or Software Instrument edit window to shift the “focus” to it, 
the parameters for that plug-in/instrument become available in the ACT dialog cells. However, your 
KB37/UX2/UX8 Controllers are not yet mapped to control any of these parameters with the Default 
preset. To configure a mapping, you can use the MIDI Learn function. 
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Here is an example of how to map the Expression Pedal controller to the Wah Position parameter of 
the GearBox Plug-In, allowing you to remotely control the GearBox Wah in real-time as you hear 
the input monitor recording signal or playback of your audio track. These mapping steps are the same 
to map any knob, button, footswitch controller to any other available parameter in the ACT MIDI 
Controller dialog as well...

•	 Open the SONAR ACT MIDI Controller dialog, and if you have not already done so, select the 
Default preset. Leave this dialog open and where you can see it.

•	 Create an audio track in your SONAR project, and record or insert an audio file so you’ll have 
something to hear your Plug-In effect applied to. A nice clean guitar recording wold work nicely 
here.

•	 Click on an FX Bin Insert slot for this audio track and insert the GearBox Plug-In.

•	 In the GearBox Plug-In window, load a Tone preset, and click on the Wah pedal effect to make 
sure it is “on” and to show the Wah effect’s edit settings in the edit panel.

The GearBox Plug-In Edit Panel, Wah effect 

•	 With your “focus” still on the GearBox Plug-In window, you should now see the many GearBox 
Plug-In parameters shown in the cells of the ACT dialog. We specifically want to access the Wah 
- Position parameter. To see this you’ll need to select Bank 4 of the top row of “Rotary” cells, and 
the Wah - Position parameter should appear in the Rotary 1 controller slot.

The Default preset is selected...

In the Controllers tab, select Bank 4 in the 
top row of cells. 

The GearBox Plug-In’s Wah-Position 
parameter appears in the Rotary 1 slot. 

•	 Click on the lower cell of the Rotary 1 controller slot and this places it in “MIDI Learn” mode, 
where it then waits to receive a MIDI command from the assigned MIDI surface control device 
(your KB37/UX2/UX8)...
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•	 Now move your Expression Pedal and you should immediately see the Rotary 1 cells switch out 
of MIDI Learn mode, meaning your Pedal’s MIDI command was “learned”, thus mapping your 
Pedal controller to the parameter. (Note that we had previously configured your Expression 
pedal to transmit MIDI CC 11 - see the “MIDI Controller Settings Dialog” on page 4•7 if you need 
to check your pedal assignment).

•	 Now just move your pedal and you should see the big Wah position knob move in response in the 
GearBox Plug-In window. Play your track and you’ll hear the Wah do its thing. 

•	 Repeat the above steps to use MIDI Learn to map any other controllers from your Line 6 device 
to other SONAR, plug-in, or instrument parameters. When done, type a new title in the Preset 
field at the top of the ACT dialog and click the Save button to save all these new mapped 
settings as a SONAR ACT preset.

SONAR’s ACT feature offers a great deal more functionality for MIDI control - please be sure to read 
the SONAR Help documentation for details! 
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MOTU Digital Performer™ - Transport Control

Here we’ve provided a step-by-step tutorial here for how to configure a Line 6 POD Studio/TonePort 
KB37, UX2 or UX8 device to remotely control the Transport of the Mark of the Unicorn’s Digital 
Performer™ 5 software. (The steps are similar for other Digital Performer versions as well). It can be 
very helpful to have remote or foot control over your Transport functions for recording and punch-ins! 

MIDI Control Assignment Configuration

The first step, before even launching Digital Performer, is that we’ll need to configure a set of MIDI 
assignments for the footswitches and pedals of our KB37/UX2/UX8 device. Digital Performer utilizes 
MIDI CC commands to access its Transport functions remotely. We can assign these MIDI CC 
commands to our Line 6 device using the Line 6 MIDI Controller Settings dialog...

For a UX2 or UX8, you can set your Footswitch controllers to send MIDI CC messages to have them 
each control a Logic Transport function. 

•	 With your UX2/UX8 connected to your USB port, go to System Preferences > Line 6 Audio-
MIDI Settings dialog

•	 Select the No Mapping preset, then click on the Settings button to launch the MIDI Controller 
Settings dialog so that we can edit the settings.

•	 For KB37, you’ll likely want to configure your on-board transport buttons to control the Digital 
Performer transport functions. Therefore, in the MIDI Controller Settings dialog, you’ll want to 
set all the Transport controllers’ settings to send MIDI CC commands, as shown here:

•	 For UX2 or UX8, you can configure your Footswitch 1 and Footswitch 2 controllers to each 
control a transport function. Look at the above MIDI Controller Settings for KB37’s Transport 
keys and choose the functions you want, then copy these settings to your Footswitch 1 and 2 
rows. 

•	 When all the above settings are complete, in the Preset field at the top right of the dialog, type 
in a title (e.g. - “Digital Performer Transport”) and click the button to save this as a preset.

•	 Click Apply, then OK to exit the dialog’

Digital Performer Configuration

With your Line 6 device connected to your computer’s USB port, launch the Digital Performer 
application and open or create a new project. The first step is to locate each transport function you 
wish to map to and allow it to “learn” the command from your controller button or footswitch.
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•	 Type <Shift+L> or select the Setup menu, Commands item.

•	 Clear any existing MIDI note mappings found within the MIDI Event column of the dialog to 
avoid unexpectedly triggering other functions.

•	 Type ‘stop’ into the search string at the top of the dialog window and click ‘Search’ (the dialog 
will scroll to the appropriate section of the list to show the transport functions).

•	 Under Transport Commands, click the cell in the “Play” row, “MIDI EVENT” column to select 
it.

•	 Press and hold down the Play button on the KB37 (or press and hold whatever UX2/UX8 
Footswitch you want to map to the Play function) until you see the selected field display the  
MIDI CC command (for our example, you should see “118|127” (the button’s momentary 
down state) - while still holding the button down, press your computer keyboard’s Enter/Return 
key to capture the command. You should see the MIDI CC now assigned in the MIDI Event 
field, like this:

•	 Repeat the same procedure for the remaining transport buttons/Footswitches; the Learn function 
should ensure that the proper MIDI CCs are captured. Note that the <enter>-while-depressed 
part is crucial, since releasing the KB37 button before accepting the captured message can cause 
it to ‘learn’ for a value of ‘0’ from the assigned CC rather than the value of 127.

•	 For all KB37 transport buttons mapped to the transport functions, the Command dialog would 
look like this:
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•	 Alternatively, you can map to the other available transport functions, such as Slow Forward 
rather than Fast Forward, if you prefer to trigger one of those with your button/Footswitch.

•	 Important: Scroll to the top of the Commands list and click the square box to the left of  ‘Master 
Master’ under the heading ‘MIDI Masters’, so it’s in a grey (active) state.

Now give your assigned device buttons/footswitches a try and Digital Performer’s transport should 
respond accordingly. Note that since we’re using the “Momentary” switch type assignments, some 
functions, such as Fast Forward, will trigger only as the button is held down.

You are not limited to mapping only to Digital Performer’s transport functions. You can configure 
MIDI CC assignments for your KB37 or UX8 additional controllers using the Line 6 MIDI Controllers 
Setup dialog, and then follow similar steps as above in the Digital Performer Commands dialog to map 
to other functions too! Please refer to the Digital Performer Help documentation for details.
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Pro Tools LE™ - Transport Control 

Here we’ve provided a step-by-step tutorial for how to configure a Line 6 POD Studio/TonePort KB37,  
UX2 or UX8 device to remotely control the Transport of the Digidesign Pro Tools LE™ 8 software. 
(The steps are similar for other Pro Tools versions as well). Configuring a MIDI Controller device for 
this task is Pro Tools is not too obvious, but pretty simple once you know the steps, and it can be very 
helpful to have remote or foot control over your Transport functions for recording and punch-ins! 

Note: For the following steps, we’re running a Mac®, but the steps are the same if you are using Windows® 
XP® or Vista®, unless otherwise noted.

MIDI Control Assignment Configuration

The first step, before even launching Pro Tools, is that we’ll need to configure a set of MIDI assignments 
for the footswitches and pedals of our KB37/UX2/UX8 device. Pro Tools utilizes MIDI Machine 
Control (MMC) commands to access its Transport functions remotely. We can assign these MMC 
commands to our Line 6 device using the Line 6 MIDI Controller Settings dialog - follow the steps for 
your specific device...

KB37

Since KB37 has onboard transport buttons, we’ll configure these buttons to control the Pro Tools 
transport. 

•	 With your KB37 connected to your USB port, go to:

•	  (Mac®) System Preferences > Line 6 Audio-MIDI Settings dialog

•	 (Windows®) Control Panel > Line 6 Audio-MIDI Settings dialog

•	 Select the MIDI Default preset, then click on the Settings button to launch the MIDI Controller 
Settings dialog so that we can view the settings.
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The settings in this preset configure all KB37’s transport button controllers to transmit the necessary 
MMC (MIDI Machine Control) commands to control the Pro Tools transport. Click OK to exit the 
dialog. 

UX2 and UX8

For a UX2 or UX8, you can set your Footswitch controllers to send MMC messages to have them each 
control a Logic Transport function. 

•	 With your UX2/UX8 connected to your USB port, go to:

•	  (Mac®) System Preferences > Line 6 Audio-MIDI Settings dialog

•	 (Windows®) Control Panel > Line 6 Audio-MIDI Settings dialog

•	 Select the No Mapping preset, then click on the Settings button to launch the MIDI Controller 
Settings dialog so that we can edit the settings.



MIDI Setup Guide: MIDI Control with 3rd Party Applications

4•24

•	 Set Footswitch 1’s To MIDI Out to “MMC” and the MIDI CC/Action to “Record Punch (Pro 
Tools)”.

•	 Set Footswitch 2’s To MIDI Out to “MMC” and the MIDI CC/Action to “Stop”. (Or, alternatively, 
you can choose whatever other two transport functions you prefer for these Footswitches).

•	 At the top right of the MIDI Controller Settings dialog, type in “PT-Transport” and click the 
Save button to save these settings as a preset. The dialog should appear like this:

•	 Click Apply and then OK to exit.

Configure Pro Tools LE for Your Line 6 device

The next step is to make a few settings within Pro Tools to allow it to receive the MMC commands 
from your KB37/UX2/UX8 device. Launch Pro Tools and open or create a new session. Then make the 
following settings.

•	 Go to the Setup menu and select Peripherals.

•	 In the Peripherals dialog, choose the Machine Control screen and make the following settings:

•	 For MIDI Machine Control (Master) - check the Enable box, choose your KB37/UX2/
UX8  device, and set the ID to “125”. Keep the Preroll set to “90” frames.

•	 For MIDI Machine Control (Slave) - check the Enable box, and keep the ID set to “126”.

•	 Exit the Peripherals dialog.

Next, we need to access the small “Pro Tools” menu on the Transport...

In the Pro Tools - Transport sub-menu, 
select “Pro Tools” so that it is checked.
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Now, in the Pro Tools - Online sub-
menu, select “MMC” so that it is 
checked.

...And that is it! Now just try pressing your assigned buttons/footswitches and you should see them  
control the Pro Tools transport accordingly!
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Steinberg Cubase®

POD Studio/TonePort KB37 can be used as a keyboard controller in Steinberg Cubase® to record 
notes and play software instruments in MIDI & Instrument tracks. Additionally, the MIDI controllers 
(buttons, knobs, wheels, footswitches, expression pedal) on KB37, as well as UX2 & UX8, can 
be configured to trigger Cubase’s transport functions, mixer faders, software instrument & plug-in 
parameters and more! To follow are the instructions for configuring KB37/UX2/UX8 to function with 
Steinberg Cubase 4 on Windows®, however, the steps should be similar for other recent Cubase® and 
Nuendo® versions on both Windows® and Mac® as well.

Note that Line 6 POD Studio & TonePort KB37, UX2 & UX8 are also capable of acting as your ASIO 
audio device for Cubase as well - you can choose within Cubase’s Device Setup > VST Audio System 
settings if you want to use set it to utilize your connected Line 6 device, or a different audio interface, 
as your ASIO device. Either way, your connected KB37/UX2/UX8 will perform the MIDI functions 
described in this chapter.

 MIDI Controller Settings Dialog

•	 First, before launching Cubase, connect your Line 6 device to your USB port and go to:

•	 (Mac®) System Preferences > Line 6 Audio-MIDI Settings dialog > MIDI tab

•	 (Windows®) Control Panel > Line 6 Audio-MIDI Settings dialog > MIDI tab

•	 Select the MIDI Default preset, then click on the Settings button to launch the MIDI Controller 
Settings dialog so that we can edit a few settings.

•	 In the Preset field, at the top right of the MIDI Controller Settings dialog, type in “Cubase” and 
then click the Save button so that you have a Cubase controller preset stored on your PC for 
your Line 6 device. 
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•	 Your settings should now look like the above for KB37. If you are using UX2 you’ll see only the 
Footswitch 1 &2 rows, and for UX8 the Footswitch 1 & 2 and Expression Pedal rows. If you are 
using KB37, you do not need to edit any of the settings in the MIDI Control Settings dialog.

•	 If you are using UX2 or UX8, you can optionally change one or both of your Footswitch controller 
settings in the MIDI Controller Settings dialog, if you want your Footswitch controllers to control 
any different Cubase transport functions. 

•	 To change Footswitch 1, select “MMC” in the To MIDI Out field, and then choose your 
preferred transport function from the MIDI CC/Action field. 

•	 Note that Footswitch 2 is already set for “MMC” and to control the Record Punch transport 
button. You can keep this or change the MIDI CC/Action field to select a different transport 
function. 

•	 Click Apply after making changes to commit them to your device. Click OK to exit the dialog.

The above steps assign MIDI commands to all the device’s MIDI Controllers for us so that we can then 
map them in Cubase. The steps also configure all KB37’s transport button controllers to transmit the 
necessary MMC (MIDI Machine Control) commands to control Cubase’s transport, and MIDI CC 
messages to trigger other Cubase functions. 

Cubase MIDI Port Setup

Since you are using your Line 6 device as a MIDI controller device, you’ll want to exclude it from 
Cubase’s “All Inputs” MIDI Port settings. This way, if you choose the “All Input” option for one of your 
MIDI tracks, the track will not receive input from your Line 6 device and record it into the track. To 
configure this setting, go to Cubase’s Devices > Device Setup dialog...
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Select MIDI Port Setup
Uncheck the “All Inputs” box for your 
KB37/UX2/UX8 MIDI In Port

Note that you’ll still be able to choose your Line 6 device within your Cubase MIDI tracks’ MIDI Input 
selector (such as your KB37 to use it as your keyboard controller). The above setting just disallows 
MIDI track input if you select “All Inputs” as the track’s MIDI Input.

Cubase Parameter Control

Cubase offers support for many 3rd party MIDI Control Surface devices - large hardware units designed 
to emulate analog mixing consoles with dozens of hardware faders, knobs and buttons. Your Line 
6 device is not one of these supported Control Surface devices, however,  it is still possible to map 
any of your KB37/UX2/UX8 MIDI controllers to Cubase’s many parameters. This is accomplished by 
configuring your Line 6 device as a Generic Remote device. To accomplish this, go to Cubase’s Devices 
> Device Setup dialog once again...

•	 If you do not already see the “Generic Remote” under the Remote Devices in the left panel, 
click on the “+” button at the top left of the dialog and choose Generic Remote from the menu 
to add it. 

Select Generic Remote Select your Line 6 device as the MIDI Input

•	 In the top right panel you will now see a list of Cubase parameters that you can map your device’s 
controllers to. The easiest way to do this mapping is to use the Learn function. For example, to 
map the “Fader 1” parameter at the top of the list to Knob 1 on KB37, follow these steps:

•	 Click directly on the “Fader 1” Control Name in the top right panel.

•	 Rotate the Knob 1 on KB37.

•	 Press the Learn button at the right of the dialog.
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•	 You should see the MIDI Channel and other settings in the Fader 1 row change, indicating 
it has “Learned” the MIDI CC message the KB37 knob 1 is transmitting. (Note that KB37/
UX2/UX8 always transmits these MIDI commands on MIDI Channel 1).

•	 Now look at the Cubase Mixer window and watch the channel strip for track 1 - you should 
see its fader respond to the KB37 knob moves.

•	 Repeat the above steps to map other controllers from your device to other Cubase parameters in 
the list. 

•	 Note that you’ll need to use knobs or pedal controllers to map to Cubase’s fader, knob and 
slider type parameters, and buttons to map to Cubase’s switch type parameters.

•	 Also, these Cubase parameters typically need to receive MIDI CC type commands, so you’ll 
want to make sure that the controller on your Line 6 device is sending this type of MIDI 
command (see “MIDI Controller Settings Dialog” on page 4•7 for how to change these).

The lower right panel also allows you to map to more channel strip parameters, beyond track 1 - 16. 
It is also possible to customize these Generic Remote parameter lists using the other options in this 
dialog. Please see the Cubase Help documentation for details.

Cubase Transport Control

Cubase allows control of its transport by way of a simple MIDI Machine Control Slave option - 
meaning it will listen for MMC commands from a selected device and respond accordingly. Since we 
assigned MMC commands to the KB37 transport buttons (and/or optionally to your device’s Footswitch 
controllers), all we need to do is set Cubase to listen to your Line 6 device for the MMC commands. 

Go to Cubase’s Transport menu and select Project Synchronization Setup...

Check the box for MMC Slave Active.

Choose your Line 6 device for the MIDI 
Input.

Click OK to exit the dialog

Now try your KB37 transport buttons, or any other controllers that you assigned to transmit MMC 
commands, and you should see Cubase’s transport respond. 
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With the 3rd party application examples covered in this chapter you should now be pretty well 
informed on how to get your POD Studio/TonePort device’s MIDI controllers up and running, and 
triggering all kinds of functions. Most other DAW applications that offer remote MIDI control can be 
configured similarly. Please see the following chapter for more helpful Line 6 online resources as well!
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Additional Online Resources
Hungry for more info? We’ve got plenty of helpful resources just a click away...

•	 Several additional Help documents covering MIDI CC references, computer recording, product 
Release Notes and more are available here:  

GearBox Online Help 

•	 For technical support, choose from the many options listed on the Line 6 Support page:

Line 6 Support

•	 Official Line 6 hardware Product Manuals for POD Studio, TonePort and all other Line 6 devices  
can be downloaded here:

Lie 6 Product Manuals

•	 Can’t get enough of that Line 6 Gear, or want to check out the latest Add-Ons and accessories? 
Head on over to the Line 6 Store!

Line 6 Online Store

•	 Join the Community! Line 6 users are welcome the Line 6 Online Community, the place to get:

•	 Free downloable Tones for POD Farm

•	 Free iTunes® and MP3 Jam Tracks.

•	 Free loops for GarageBand®, Acid®, Reason® and more.

•	 Free guitar lessons from LA session pros.

•	 Breaking news, links and video clips.

•	 Info on contests and special offers.

•	 Access to discussion forums, software updates and more.

Line 6 Community

http://line6.com/support/knowledgebase/toneporthelp/
http://line6.com/support/
http://line6.com/support/manuals/
http://www.line6.com/store/storefront.html
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